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How Warehouse Connector Works

Warehouse Connector collects meta and events from Decoder and Log Decoder and writes them in
AVRO format into a Hadoop-based distributed computing system. You can set up Warehouse Connector
as a service on existing Log Decoders or Decoders.

The Warehouse Connector contains the following components:
o Data Source
o Destination

o Data Stream

Data Source

A data source is the service from which the Warehouse Connector collects data to store in the
destination. The supported data sources are Log Decoder and Decoder services.

Destination

Destination is the Hadoop-based distributed computing system that collects, manages, and enables
reporting on security data. The following are the supported destinations:

o« RSA NetWitness Warehouse (MapR) deployments
o HortonWorks Data Platform

o Any Hadoop-based distributed computing system that supports WebHDFS or NFS mounting of HDFS
file systems.

o Example: Commercial MapR M5 Enterprise Edition for Apache Hadoop

Data Streams

A data stream is a logical connection between the data source and destination. You can have multiple
streams for different subsets of data collected. You can setup streams to segregate data from multiple
Decoder and Log Decoder services. You can create a stream with multiple data sources and a single
destination or with a single data source and destination.

The Warehouse Connector does the following:

o Aggregates session and raw log data from Decoders and Log Decoders.

o Transfers the aggregated data into supported destinations like Hadoop based deployments.
o Serializes the aggregated data that includes both schema and data into AVRO format.

In addition the Warehouse Connector also supports the following:

Meta Filters

Meta filters enables you to filter the meta keys that should be written into the Warehouse. For more
information, see Specify Meta Filters for a Stream.

Support for Multi-Valued Meta Keys

How Warehouse Connector Works 4
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RSA NetWitness Warehouse supports multi-valued meta keys. The multi-valued meta keys is the meta
field with the array type. You can use the meta keys library to determine the meta fields of type array
and write HIVE queries with the correct syntax for arrays. By default, the following meta keys are
treated as multi-valued and are defined in the file, multivalue-bootstrap.xml located at
/ete/netwitness/ng in the Warehouse Connector:

o alias.host
e action

e username
o alias.ip
o alias.ipv6
o cmail

o device.group

o event.class

Checksum Validation

Warehouse Connector enables you to validate the file integrity of the AVRO files that are transferred
from the Warehouse Connector to the data destinations. You need to enable checksum validation while
you configure the Warehouse Connector.

Lockbox Support

Lockbox provides an encrypted file that Warehouse Connector uses to store and protect sensitive data.
You need to create the lockbox by providing a lockbox password while configuring the Warehouse
Connector for the first time.

You can orchestrate Warehouse Connector on a Log Decoder or a Decoder appliance.

The following is an overview of the entire process of installing and configuring the Warehouse
Connector service on Log Decoder or Decoder, configuring the Warehouse Connector service on
NetWitness, configuring data sources, destinations, streams for Warehouse Connector, and configuring
alert notifications on NetWitness.

5 How Warehouse Connector Works
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Install Warehouse Connector
Service on a Log Decoder or
Decoder

Configure a Warehouse Configure a Destination Add Warehouse as a Data
Connector Service Source to Reporting

Engine
Create a Lockbox

Configure Destination
using NFS, SFTP, and
WebHDFS

Analyze a Warehouse
Configure a Stream Report

Configure the Data Source
for Warehouse Connector

Create a Stream

Update the Port Number
and SSL Settings of the
Data Source

Finalize the Stream

Start the Stream

Monitor a Warehouse
Connector

Manage a Stream and
| Lockbox

Edit a Stream

Reload the Stream

Specify Meta Filters for
| a Stream

Define Multi-valued
Metas

| Change or Refresh |
| Lockbox |

To install and configure the Warehouse Connector service, perform the following:

L.

o ® N N kWD

Install Warehouse Connector service on a Log Decoder or Decoder

Configure a Warehouse Connector service

Configure the Data Source for Warehouse Connector

Configure a Destination

Configure a Streams

Monitor a Warehouse Connector

Add Warehouse as a Data Source to Reporting Engine

Analyze a Warehouse Report

Manage a Stream and Lockbox
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Install Warehouse Connector Service on a Log

Decoder or Decoder or Hybrid

To install (fresh install) the Warehouse Connector service on a Log Decoder or Decoder or Hybrid:
1. Log on to the Log Decoder or Decoder host.

2. Enter the following command on NetWitness Server:
warehouse-installer --help
The command line interface (CLI) usage descriptions are displayed.

4. Install Warehouse Connector service by executing either of the following commands:
warehouse-installer --host-addr 10.0.0.0
warehouse-installer --host-id 5928b9d8-83be-4143-9602-fa936debc4dle
warehouse-installer --host-name NWllAdminServer
Where,
10.0.0.0 - IP address of the Host
5928b9d8-83be-4143-9602-fa936de5c41e - Host ID
NWI11AdminServer - Host name

The Warehouse Connector service is successfully installed on the Log Decoder or Decoder or Hybrid.

7 Install Warehouse Connector Service on a Log Decoder or Decoder or Hybrid
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Configure a Warehouse Connector Service

You can configure the Warehouse Connector service using the following procedure.

To set the Lockbox password:

1.
2.

Log on to NetWitness Platform.
Go to ADMIN > Services.

In the Services view, select the added Warehouse Connector service, and select - > View

> Config.

In the Services Config view of Warehouse Connector, click the Lockbox Settings tab.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

% Change Service | Warehouse Connector | Config

Sources and Destinations ~ Streams [WESSNNSEIIUEEN General  Appliance Service Configuration

Create New Lockbox

e the lockbox password. The password should satisfy lockbox password strength. You wil be required to enter this password to perform any lockbox management.

Lockbox Password B id
Confirm Lockbox Password iebiid
Apply

Change Lockbox Password
(Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password IhEEEERR
[New Lockbox Password FkERERRA

Confirm New Lockbox Password | ** ik

Apply

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password FhkRERE

Apply

In the Create New Lockbox section, perform the following:

a. Inthe Lockbox Password field, enter the new lockbox password.

Note: The lockbox password must be at least eight characters in length and it must contain at
least three of the following groups: one uppercase character [A-Z], one lowercase character
[a-z], one numeral [0-9], and one special character.

b. Inthe Confirm Lockbox Password field, enter the added lockbox password to confirm.

c. Click Apply.
The Lockbox password is set.

Configure a Warechouse Connector Service 8



Warehouse Connector Configuration Guide

Configure the Data Source for Warehouse Connector

To configure the data source:
1. Log on to NetWitness Platform.
2. Go to ADMIN > Services.

3. Inthe Services view, select the added Warehouse Connector service, and select - > View >
Config.

The Services Config view of Warehouse Connector is displayed.

4. On the Sources and Destinations tab, in the Source Configuration section, click +.

Available Services

}5( Name ~ Address Type
& Decoder Decoder
i Log Decoder Log Decoder

Cancel QK

5. Inthe Available Services dialog, select the Log Decoder or Decoder services that you want to add
as a source to the Warehouse Connector service and click OK.
The selected Log Decoder and Decoder services are listed in the Source Configuration section.

9 Configure the Data Source for Warechouse Connector
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Update the Port Number and SSL Settings of the Data Source

If there is change in the port number or SSL settings of the data sources used in the Warehouse

Connector, you can directly update these details in Warehouse Connector, using the Explore view of the
Warehouse Connector.

Make sure that:

e You have the updated port number or SSL settings of the data source.

o You stop the streams related to the data source that you want to update the port number or SSL
settings.

To update the port number or SSL settings:

1. Log on to NetWitness Platform.

2. Goto ADMIN > Services.

3. Inthe Services view, select the added Warehouse Connector service and select o > View
> Explore.

The Service Explore view of Warehouse Connector is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Services

% Change Service | Warehouse Connector | Explore

= Warehouse Connect... undefined Warehouse Connector (Warehouse Connector)
s

|2 = Warehouse Connector (WAREHOUSE C...

aaaaaaa

< >

4. Navigate to warehouseconnector/sources, right-click the source, and click Properties.
The Properties section of the source is displayed.

Configure the Data Source for Warehouse Connector 10
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Services

4 Change Service | Warehouse Connector | Explore &

1 ‘Warehouse Cannector (Warehouse Connector)

= Warehouse Connect...

= &5 Warehouse Connector (WAREHOUSE_CO...

connections

logs
B[] connections

B logs

[rest

rest
services
storedproc
[ services
sys
B[ storedproc users
805y warehousaconnactor

B Jusers devicesppliance

[Jwarehouseconnector
[ config
B[] destinations I
[Jsources
]
{iu]
(=B

[T deviceappliance

Properties

< 2>

5. In the drop-down menu, select update. In the Parameters field, perform the following:

o To update the port number of the source, enter port=<new source portnumber> and click
Send.

‘ Parameters port=443 Send

o To update the SSL settings of the source, enter ss1=<new ssl settings> and click Send.

Parameters ssl=on Send |

Note: You can also update the port number and ssl settings simultaneous by adding space
between the parameters.

| Parameters port=443 ssl=on Send ‘

6. Restart the Warehouse Connector service.

7. Start the streams.

11 Configure the Data Source for Warechouse Connector
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Configure the Destination

You can configure the destination using NFS, SFTP, and WebHDFS. Change the destination to which
the Warehouse Connector service needs to write the collected data using NFS:

o RSA NetWitness Warehouse (MapR) deployments
o Commercial MapR M5 Enterprise Edition for Apache Hadoop deployments

You can configure the Warehouse Connector to write to a remote destination using Secure File Transfer
Protocol (SFTP). The remote destination can be a remote server that is NFS mounted to the MapR
cluster or it can be a remote staging server.

By default, in the remote destination the Warehouse Connector writes data in the following directory
structure:

e /<staging
folder>/rsasoc/vl/sessions/data/<year>/<month>/<day>/<hour>/

e /<staging folder>/rsasoc/vl/logs/data/<year>/<month>/<day>/<hour>/
Where <staging folder> is the folder on the remote server where the Warehouse Connector writes the
data.

If you are using a remote staging server as the remote destination, you need to manually copy or move
the directory structure to any of the following deployments:

o RSA NetWitness Warehouse (MapR)

o Commercial MapR M5 Enterprise Edition for Apache Hadoop

o HortonWorks HD

To generate reports from the data written by Warehouse Connector, make sure that in your

Hadoop deployment you maintain a similar directory structure that is created by Warehouse Connector in
the remote destinations.

Configure the Destination 12
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The following illustration describes how you can use SFTP to write data from Warehouse Connector to a
remote destination.

|
i
| | |
WC writes data in the *Directory ! l @ @ I
Structure mentioned below l ! I !
! |
l DO L
&
|

MapR Cluster Reporting

|

|

|

|

I

I

|

I

| |
| Maintain the *Directory Structure | |
| as mentioned below | i
| | |
|

|

I

|

|

I

|

|

I

Remaote perver

|

|

I

|

|

Warehouse l
Connector (WC) ————5FTP !
|

|

|

|

|

|

| Reporting Engine

i |

. i

' By
Manually/| Pl‘rogrammatically_l_]! @

s

=
SHiE & S YGI R O e Gt | MapR Cluster / Pivotal HD -
| Maintain the *Directory Structure I
WC writes data in the *Directory i as mentioned below :
Structure mentioned below I :
[ mce e e e e e 4

*Directory Structure: /
- [<staging_folder=/rsasoc/vl/sessions/data/<year>/<month>/
<day>{<hour>/

- [<staging_folder={rsasoc/vl/logs/data/<year>/<month>/<day>/
<hour>/

Y ou can configure the Warehouse Connector service to write the collected data to a Hadoop-
based distributed computing system that supports WebHDFS.

13 Configure the Destination
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Configure the Destination Using NFS

Make sure that you have:
o Installed the Warehouse Connector service or virtual appliance in your network environment.

o Added the Warehouse Connector service to NetWitness. For more information, see "Add a Service
to a Host" in the Hosts and Services Getting Started Guide.

o Set up NFS on Warehouse Connector. For more information on how to set up NFS on Warehouse
Connector, see "Configure Warehouse Connector to Write to Warehouse" in the Warehouse (MapR)
Configuration Guide.

To configure the destination using NFS:

1. Log on to NetWitness Platform.

2. Goto ADMIN > Services.
ﬁ -

3. Inthe Services view, select the Warehouse Connector service, and select > View > Config.

The Services Config View of Warehouse Connector is displayed.

INVESTIGATE MONITOR CONFIGURE ADMIN

% ChangeService | Warehouse Connector | Config

COMECENRI BRI streams  Lockbox Settings ~ General  Appliance Service Configuration

Source Configuration Destination Configuration

+ +

| adaress Port O Name Type Path

1 1031125245 56004 [ NFs nfs froot/test/kaushal
1 1031125248 56002 O sFp sftp froot/test

4. On the Sources and Destinations tab, in the Destination Configuration section, click +.

5. Inthe Add Destination dialog, select NFS from the Type drop-down list.

6. Inthe Name field, enter a unique symbolic name for the destination.

Note: The Name field does not support spaces or special characters except underscore ().

7. In the Local Mount Path field, enter the locally mounted directory for HDFS where you want the
Warehouse Connector to write the data. For example:
If /saw is the local mount point for HDFS that you have configured while mounting the

Configure the Destination 14
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8.
0.

mapr NFS cluster on the host where you have installed the Warehouse Connector service to write to
RSA NetWitness Warehouse (MapR), create a directory named Ionsaw01 under /saw and the
corresponding Local Mount Path for the destination would be /saw/Ionsaw01.

For more information, see "Mount the Warehouse on the Warehouse Connector" topic in the
Warehouse (MapR) Configuration Guide.

Add Destination

Type * NFS| v

Mame *

Local Mount Path *

Cancel Save

The /saw mount point implies to / as the root path for HDFS. The Warehouse Connector writes the
data to /Ionsaw01 in HDFS.

Click Save.
(Optional) If you want to enable checksum validation, perform the following:

a. Goto ADMIN > Services.

ﬁv

b. In the Services view, select the added Warehouse Connector service, and select
> Explore.

The Explore view of Warehouse Connector is displayed.

> View

Warenouse Connector (Warehouse Connector)

= Warehouse Connect...

nnnnnnnnnn

=55 Warehouse Connector (WAREHOUSE C...

< >

RS /\ NETWITNESS® PLATFORM 1

c. In the options panel, navigate to warehouseconnector/destinations/nfs/config. This is the name
of the destination and is dynamic.

d. Set the parameter 1 sChecksumValidationRequiredto 1.

15
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RSA RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN @ admin© (@)

Services

£ Change Service | Warehouse Connector | Explore ©

— Iwarehousecnnector/cestinations/NFS/config ‘Warahouse Connactor (Warehouse Connector)
=Warehouse Connect...

isChecksumValidationRequired 1

E 5 Warehouse Connector (WAREHOUSE_CO..

root Iroat/iest/kaushal
[ connections
loes
B rest

B services

subtype nfs

pe hdfs

[T storedproc
Csys
B users

B[] warehouseconnector
[Jconfig «
B[] destinations
E[INFS
[Jeonfig
alasre
BT sources
[ stats
@[] deviceappliznce

< >

RS /\ NETWITNESS  PLATFORM

e. Restart the respective stream.
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Configure the Destination Using SFTP

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the Warchouse Connector service to NetWitness. For more information, see the "Add a
Service to a Host" in the Hosts and Services Getting Started Guide.

For the SFTP destination type, the destination host should be listed in the /root/.ssh/known_hosts file
used by the ssh service (for example, sshd) running on the Warehouse Connector.

Add Destination from Warehouse Connector Host

To add the destination host to the /root/.ssh/known_hosts file, from the Warehouse Connector host,
initiate a secure connection to the destination host:

L.

2
3.
4

Login to the Warehouse Connector.

. Enter ssh root@<SAWIP> Or ssh username@<SAWIP>.

Select Yes and enter the password.

. Add the host key in the /root/.ssh/known_hosts file

Note: After you upgrade Warehouse Connector to 11.0, you must make sure that the destination
host is listed in the /root/.ssh/known_hosts file used by the ssh service (i.e. sshd) running on the
Warehouse Connector. If you do not perform this action, the streams configured with SFTP in
Warehouse Connector will not start.

If you want to use SFTP to write data into the destination using SSH key-based access, you need to
configure SSH key-based access between the Warehouse Connector and the Warehouse host
or Hadoop node. For more information, see Configure SSH Keys below.

Note: If you want to enable checksum validation to validate the integrity of the AVRO files that are
transferred from the Warehouse Connector to the destinations, make sure that you generate the keys
without setting the passphrase and do a key exchange between warehouse connector and the
warehouse nodes.

17
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Configure Warehouse Connectorto use SFTP destination
To configure the destination:

1. Log on to NetWitness Platform

2. Go to ADMIN > Services.

3. Inthe Services view, select the added Warehouse Connector service, and select - > View
> Config.

The Services Config view of Warehouse Connector is displayed.

RSA RES INVESTIGATE MONITOR CONFIGURE  ADMIN

ctor | Config

LIS ENRLEESIESSl  Streams  Lockbox Settings ~ General  Appliance Service Configuration

Source Configuration Destination Configuration

+ +

| Address Port [0 Name Type Path

1 1031125245 56004 O NFs nfs /froot/test/kaushal
1 1031125248 56002 O sFe sftp froot/test

RS /\ NETWITNESS' PLATFORM

4. On the Sources and Destinations tab, in the Destination Configuration section, click +.

5. Inthe Add Destination dialog, select SFTP from the Type drop-down list.

Add Destination

Type * SFTP w
Mame *

Host *

Port * 22 o
Usarname *

Password/Passphrase Fk kg kA

Remote Path *

Cancel Save

Configure the Destination 18
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6.

10.

11.
12.
13.

In the Name field, enter a unique symbolic name for the destination.

Note: The Name field does not support spaces or special characters except underscore ().

In the Host field, enter the remote server IP address.
In the Port field, retain the default port, 22.

In the Username field, enter the SSH username.

Note: In the case of HortonWorks HD, ensure that the username is gpadmin and for password
based access the password for gpadmin should be used. For passphrase-based access, the
passphrase used to generate the keys for gpadmin user should be used.

In the Password/Passphrase field, enter one of the following:

m SSH password - If you are using SFTP to write data into the destination using password-based
access.

m SSH passphrase - If you are using SFTP to write data into the destination using SSH key-based
access.

In the Remote Path field, enter the path of the directory present on the SFTP server.
Click Save.
(Optional) If you want to enable checksum validation, perform the following:

a. Goto ADMIN > Services.
ﬁ -

b. In the Services view, select the added Warehouse Connector service, and select > View
> Explore.

The Explore view of Warehouse Connector is displayed.

CONFIGURE ADMIN

Warehouse Connector (Warehouse Connector)

= Warehouse Connect...

connections

= 5 Warehouse Connector (WAREHOUSE C...

< >

RS /\ NETWITNESS" PLATFORM 1

c. In the options panel, navigate to warehouseconnector/destinations/sftp/config.

19
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Set the parameter i sChecksumValidationRequired to 1.

SA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

urces Heal

e Connector |  Explore

Security

= Warehouse Connect...

7' &3 Warehouse Connector (WAREHOUSE_CO...

known hosts.file
password
B connections
I

Diogs isChecksumValidationRequired
ress

Brest host
[ services

[ storedproc

root

eeeeeeee
B0y subtype
B users
B8 warehouseconnector
Cleonfig
B[ destinstions
BINFs
LimbEag
Bty

iwarenouseconnector/destinations/SFTP/config

10.31.204.44:22
hdfs
root

sftp

e. Restart the respective stream.

Configure SSH Keys

To configure SSH key-based access between the Warehouse Connector and the Warehouse host or

Hadoop node:

1. Generate SSH keys on the Warehouse Connector at the default location. Perform the following:

Log on to the Warehouse Connector.

Type the following command and press ENTER:

$ OWB_FORCE FIPS MODE OFF=1 ssh-keygen -t dsa

The command prompts you to enter the file in which to save the generated key.
Enter file in which to save the key (/root/.ssh/id dsa):
Enter the file in which you want to save the key and press ENTER.

The command prompts you to enter and confirm the passphrase.

Note: If you want to enable checksum validation to validate the integrity of the AVRO files
that are transferred from the Warehouse Connector to the destinations, make sure that you do
not set the passphrase. Then, the below steps e, f, g, and h are not applicable.

Enter passphrase (empty for no passphrase):

Enter same passphrase again:
The public key is generated and is saved in the location that you provided.
Change the directory by entering the following command:

cd /root/.ssh/

Configure the Destination
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f. Move the generated key to the below location:
mv id dsa id dsa.old
g. Type the following command and press ENTER:

$ OWB FORCE FIPS MODE OFF=1 openssl pkcs8 -topk8 -v2 des3 -in id dsa.old
-out id dsa

The command prompts you to enter and confirm the passphrase.

h. Enter the encryption passphrase.

i. Run the following command to change the file permission:

chmod 600 id dsa

2. Append the generated public key to the remote Warehouse host or Hadoop node's authorized keys list
located at: ~/.ssh/authorized keys

Note: Make sure that you copy the public keys to the Hadoop node and while copying the public
key ensure that you provide the login details of the user using which the WebHDFS destination
would be added.

You can now securely communicate between Warehouse Connector and Warehouse nodes or Hadoop
nodes.

21 Configure the Destination
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Configure the Destination Using WebHDFS

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the Warehouse Connector service to NetWitness. For more information, see the "Add a
Service to a Host" in the Hosts and Services Getting Started Guide.

Added the hostname (or FQDN) and IP address of the warehouse nodes and Warehouse Connector to
the DNS server. Ifthe DNS server is not configured, add the hostname (or FQDN) and IP address of
the warehouse nodes and Warehouse Connector to the file in the host on which the Warehouse
Connector service is installed.

If you want Kerberos authentication between the warehouse connector and the warehouse cluster,
make sure that you perform the following:

o Kerberos Key Distribution Center (KDC) Server is configured in your network environment and
the Kerberos Keytab file is copied to the host on which you have installed Warehouse Connector.

o Kerberos authentication is enabled in the warehouse cluster.

If you want to enable checksum validation to validate the integrity of the AVRO files that are
transferred from the Warehouse Connector to the destinations, make sure that you generate the keys
without setting the passphrase and do a key exchange between the Warehouse Connector and the
warehouse nodes. You need to configure SSH key-based access between the Warehouse Connector
and the Warehouse host or hadoop node. For more information, see 'Configure SSH Keys' in
Configure the Destination Using SFTP.

Configure the Destination 22
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Configure Warehouse Connector to Write to SFTP destination
To configure the destination:

1. Log on to NetWitness Platform.

2. Goto ADMIN > Services.

3. Inthe Services view, select the added Warehouse Connector service and select - > View
> Config.

The Services Config view of Warehouse Connector is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

% Change Service | Warehouse Connector | Config

MECENLLENENRIEE  streams  Lockbox Settings ~ General  Appliance Service Configuration

Source Configuration Destination Configuration

+ +

7| Adaress Port O Name Type Petn

| 1031.125245 56004 [ NFs nfs Iroot/test/kaushal
| 1031.125.248 56002 O sfp sftp Iroot/test

4. On the Sources and Destinations tab, in the Destination Configuration section, click +.

5. Inthe Add Destination dialog, select WebHDFS from the drop-down list.

Add Destination

Type * WebHDFS ~
Mame *
Hadoop IP *

Hadoop Port *

£

Username *
Hadoop Path *

Kerberos Authentication [

Cancel Save
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10.

11.

12.
13.

In the Name field, enter a unique symbolic name for the destination.

Note: The Name field does not support spaces or special characters except underscore ().

In the Hadoop IP field, enter the namenode IP address of the warehouse cluster.
In the Hadoop Port field, enter the base port that is used by the namenode web user interface.

In the Username field, enter the owner of the directory in the warehouse to which Warehouse
Connector should write the data.

In the Hadoop Path field, enter the path of the directory in the warehouse to which Warehouse
Connector should write the data.

Select the Kerberos Authentication checkbox, if you want the warehouse connector to securely
communicate with the warehouse using Kerberos authentication.

Add Destination

Type * WebHDFS ~
Mame *

Hadoop IP *

r

Hadoop Port *

Usernames *
Hadoop Path *

Kerberos Authentication [

Kerberos Principal *

Kerberos Keytab File
Path *

Cancel Save

Perform the following:
a. Inthe Kerberos Principal field, enter the KDC Principal used for Kerberos authentication.

b. Inthe Kerberos Keytab File Path ficld, enter the path of the Kerberos Keytab file in the
Warehouse Connector.

Click Save.
(Optional) If you want to enable checksum validation, perform the following:

a. Goto ADMIN > Services.

b. In the Services view, select the added Warehouse Connector service and select 8 > View
> Explore.
The Explore view of Warehouse Connector is displayed.

Configure the Destination 24



Warehouse Connector Configuration Guide

RSA RESPOND  INVESTIGATE MONITOR CONFIGURE  ADMIN @ admin © D

% Change Service Warehouse Connector | Explore &

- Jr— Warehouse Connector (Warehouse Connector)
= Warehouse Connect...
[ £ Warehouse Connector (WAREHOUSE C...

logs
B[ connections
rest
B Tlogs
senvices
B0res:
storedproc
e sys
B Jstoredproc users
B0sys warehouseconnector
B[ Jusers deviceappliance

B[ Jwarehouseconnector
config ‘
Cstats

B[ devicesppliance

< >

RS /\ NETWITNESS  PLATFORM ;

c. In the options panel, navigate to warehouseconnector/destinations/webhdfs/config.

d. Set the parameter isChecksumvValidationRequired to 1.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE  ADMIN @ admin® @

Services Event Sources le

& Change Service | Warehouse Connector |  Explore @

,, IwatenouseconnectorsestnationsANFS confg Warahouse Connector (Warehousz Comnector)
= Warehouse Connect...
isChecksumValidationRequired 1
f= & Warehouse Connector (WAREHOUSE_CO..
B connections
subtype nfs
logs
Dlteg ype hdfs
B rest

B 3services
B[ Jstoredproc
8 0sys
B Tusers
& [Jwarehouseconnector
[Jconfig 4
B[ destinations
BONFS
asre
B [Jsources
Cstas

& [ devicesppliance

< >

e. Restart the respective stream.
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Configure a Stream

You can configure the data stream to define the data source and destination combinations.

Make sure that you have:

Installed the Warehouse Connector service or virtual appliance in your network environment.

Added the Warehouse Connector service to NetWitness. For more information, see "Add a Service to
a Host" in the Hosts and Services Getting Started Guide.

Configured the data source from which the Warehouse Connector service needs to collect data. For
more information, see Configure the Data Source for Warehouse Connector.

Configured the destination to which the Warehouse Connector service needs to write the collected
data. For more information, see Configure the Destination.

To configure the stream:

L.
2.
3.

Create a stream
Finalize the stream

Start the stream
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Create a Stream

To create a stream:

L.

2. Inthe Services view, select the added Warehouse Connector service and select

Go to ADMIN > Services.

o > View >
Config.

The Services Config view of Warehouse Connector is displayed.

Click the Streams tab.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Sen

& ChangeSenvice | Warehouse Connector | Config @

Sources and Destinations [ECUSTNCM LockboxSettings ~ General  Appliance Service Configuration

1 name Sources Destination Status

(] L] running

7o configure the alert mechanisms related to the Warehouse Connector navigate here.

RS /\ NETWITNESS’ PLATFORM
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4. On the Streams tab, click +.
Add Stream

Stream Mame * |

Select Destination * Choose Destination ... W

Select Source *

L] Name Address Port Session |D
O 56004 Enter Session
[l 56002 Enter Session

Cancel Save

5. Inthe Add Stream dialog, perform the following:

a. Inthe Stream Name field, enter a name for the stream.

0.

Note: The Stream Name ficld does not support spaces or special characters except underscore

b. Inthe Select Destination drop-down menu, select a destination from the list of destinations
added to the Warehouse Connector.

c. Inthe Select Source field, select sources from the list of sources displayed.

d. Inthe Session ID column, enter the last session id.
If you provide any session id, the Warehouse Connector will start the aggregation from that
session, whereas if this is left blank, the aggregation will start from the current session.

e. Click Save.

Configure a Stream
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Finalize the Stream

Make sure that you have created a stream.
To finalize the stream:

1. Goto ADMIN > Services.
o

2. Inthe Services view, select the added Warehouse Connector service and select > View >

Config.
The Services Config view of Warehouse Connector is displayed.

3. On the Streams tab, select the stream that you have created.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

& Change Service | ‘Warehouse Connector | Config

Sources and Destinations [ESICCHISM Lockbox Settings ~ General  Appliance Service Configuration

O Name Sources Destination status

O o 50002 running

lert mechanism: e Connector navigate here.

4. Click Finalize.
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Start the Stream

Note: If you have deployed a Warehouse Connector Virtual Appliance, make sure that you change the
default value of the Maximum Message Hold Count parameter to 800000. For more information,
see General Tab Settings.

To start the stream:

1. Goto ADMIN> Services.
.:} -

2. Inthe Services view, select the added Warehouse Connector service and select
Config.

The Services Config view of Warehouse Connector is displayed.

> View >

3. On the Streams tab, select the stream that you have created.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

& Change Service | Warehouse Connector [N -34S

Sources and Destinations [ECUSINEM Lockbox Settings ~ General  Appliance Service Configuration

= & | start | Change Configuration

Destination Status

& o 50002 stopped

To configure the alert mechanisms related to the Warehouse Connector navigate here.

RS /\ NETWITNESS' PLATFORM

4. Click Start.
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Monitor a Warehouse Connector

By monitoring a Warehouse Connector, you can automatically generate notifications when critical
thresholds concerning Warechouse Connector and its storage have been met.

To monitor a Warehouse Connector:

Go to ADMIN > Services.

1.

In the Services view, select the added Warehouse Connector service and select

.ﬁ.v

> View

> Config.
The Services Config view of Warehouse Connector is displayed.

Click the Streams tab.

At the bottom of the Streams tab, click To configure the alert mechanisms related to the
Warehouse Connector navigate here.
The Warehouse Connector Monitoring page is displayed.

Caution: This page is deprecated and will be removed in a future release.

5. Inthe Source or Destination Status section, select the number of minutes or hours in the Notify
After Failing For field.

You will receive a notification if the source or destination connection fails for the defined number of
minutes or hours.

In the Stream Status section, perform the following:

a.

In the Notify Stopped For field, define the number of minutes or hours after which you would
like to receive a notification when the stream goes offline.

In the Disk Is field, define the limit on the percentage of disk usage after which you would like to
receive a notification.

In the Source is Behind field, define the number of sessions. A notification is raised if the
source goes behind the defined number of sessions.

In the Rejected Folder Size is field, define the limit on the percentage of folder usage after
which would like to receive a notification.

. In the Number Of Files in Permanent Failure Folder field, define the limit on the number of

files in the permanent failure folder after which you would like to receive a notification.

7. In the Notification Type field, perform the following:

a.

Click Configure email or distribution list to configure email so that you can receive
notifications in NetWitness. For more information, see the "Configure Email Server and
Notification Account" topic in the System Configuration guide.

Click Configure Syslog and SNMP Trap servers to configure audit logs. For more information,
see the "Configure Syslog and SNMP Settings" topic in the System Configuration guide.
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c. Select the following notification mechanisms as per your requirement:

o NetWitness Console - To get notifications on the NetWitness Ul notification toolbar.

o Email - To get email notifications.
« Syslog Notification - To generate syslog events.

o« SNMP Trap Notifications - To get audit events as SNMP traps.
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Add Warehouse as a Data Source to Reporting Engine

You must add Warehouse as a data source to Reporting Engine to make this data source available to
reports against this Reporting Engine. For more information, see "Add Warehouse as a Data Source to
Reporting Engine" in the Reporting Engine Configuration Guide.
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Analyze a Warehouse Report

The Warehouse modules provide analysts with reports of early indicators of compromise. The following
Warehouse reports can be analyzed in NetWitness:

o Suspicious Domains report
o Suspicious DNS Activity report
o Host Profile report

For more information, see "Step 4. Analyze a Warehouse Report" in the Warehouse Guide.
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View the Warehouse Connector Service

While the information displayed in the Services System view is the same for all types of core services,
several options in the toolbar are relevant only for Warehouse Connector.

To access this view:

1. Goto ADMIN > Services.

2. Inthe Services view, select a Warehouse Connector and select - > View > System.
The Systems view for the selected Warehouse Connector is displayed.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Services

# Change Service | Warehouse Connector | System

B HostTasks O Shutdown Service () Shutdown Appliance Service ) Reboot

Warehouse Connector Service Information Appliance Service Information
Decoder (Warehouse Connector) Decoder (Host)
11.1.0.0 (Rev null) 11.2.0.0 (Rev null)

29640 KB (0.09% of 32176 MB) 26700 KB (0.08% of 32176 ME)

145 0%
2018-Apr-26 09:33:59 ‘ 2018-Apr-26 09:07:00

3 days 23 hours 4 minutes 17 seconds 3 days 23 nours 31 minutes 23 seconds

tTime  2018-Apr-30 03:38:16 Time  2018-Apr-30 08:38:23

Warehouse Connector User Information Host User Information
admin admin

Administrators Administrators

connections.manage, logs.manage, services.manage, storedproc.execute,

appliance.manage, connections.manage, logs.manage, services.manage,
storedproc.manage, sys.manage, users.manage, warehouseconnector.manage

storedproc.execute, storedproc.manage, sys.manage, users.manage

Session Information

Session User 1P Address Login Time ~ Active Queries
171 admin [:1):35428 0
admin [:1):35430 0
escalateduser 10.31.125.251:58208 0

The following is an example of toolbar options for Warehouse Connectors.

B HostTasks (U shutdown Service (U Shutdown Appliance Service () Reboot

Host Tasks, Shutdown Service, Shutdown Appliance Service or (Shutdown Appliance), and Reboot are
common to all services and are described in the Hosts and Services Getting Started Guide.
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Troubleshoot the Warehouse Connector

The following information suggests the possible issues that NetWitness users may encounter when
adding a Warehouse service to the Reporting Engine as a data source for reporting in NetWitness. Look
for explanations and solutions in this section.

While adding a Warehouse service to the Reporting Engine as a data source for reporting, you may
observe some of the errors listed in this document. Information is provided on how to troubleshoot the
errors and add the data source successfully.

The following figure shows the New Service dialog.

Mew Service

Source Type * WAREHOUSE ~
Warehouse Source * HiveServer? w
Mame * PDHZ2.0-DCA

HDFS Path * !

Advanced |

Host #

Paort * 10000

Username * gpadmin

Pa ESWG'rd TEEELETEE

Kerberos Authentication [+

Server Principal *
User Principal *
Kerberos Keytab File *

Enable Jobs O

Test Connection

Cancel Save

For more information, see "Add Warehouse as a Data Source to Reporting Engine" in the Reporting
Engine Configuration Guide.
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_ Possible Solutions

Could not open connection to e Ensure that the HiveServer2 is running on the Host.
HiveServer

o Check if the port provided can be accessible from the Reporting
Engine server.

No Schema found in HDFS  Ensure that meta avro data file(s) are available in the HDFS path
path (<HDFS Path>/rsasoc/vl/sessions/meta) mentioned.

The following figure shows an example of the command to check the
files in hdfs.

Could not open connection to  GSS initiate failed errors will be observed only in the case of Kerberos

HiveServer, GSS initiate enabled Hive.

failed Ensure that the proper keytab file is provided and it should have read
options for the rsasoc user (user on which the Reporting Engine Server
runs).
Ensure that the system time is synchronized between KDC, Hadoop
(HortonWorks) server, and the Reporting Engine system.
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Manage a Stream and Lockbox

You can manage a stream using the following procedures:

Edit a Stream
Reload the Stream
Specify meta filters for a Stream

Define muti-valued metas

Edit a Stream

You can edit a stream to perform the following:

Add more data sources to the stream.

Delete existing data sources from the stream.

To edit a stream:

1.

3.
4.

Go to ADMIN > Services.
ﬁ -

In the Services view, select the added Warehouse Connector service and select > View
> Config.

The Services Config view of Warehouse Connector is displayed.

RSA RESPO INVESTIGATE MONITOR CONFIGURE ADMIN

& Change Service | Warehouse Connector | Config &

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Source Configuration Destination Configuration

+ +

[ adaress pore O Name Type path

| 1031125245 56004 O nrFs nfs froot/test/kaushal

|1 1031125248 56002 [ sFe sfp Jroot/test

R'S /\ NETWITNESS PLATFORM

On the Streams tab, click 4
In the Edit Stream dialog, you can perform the following:

o On the Available Sources tab, you can select the available data sources to add to the stream and
click Save.
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Edit Stream

Stream Mame

Destination

Available Sources

D Mame Address Port Session 1D

] 50004 20004 Enter Session

Cancel Save

e On the Current Sources tab, you can delete an existing data source from the stream. Select the

data source and click = .

Edit Stream

Stream Mame

Destination

PR SRl gu= 9 Current Sources

At least one source is required

L] Name Address Port

O :50002 50002

Cancel Save

Reload the Stream
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When you reload the stream, the Warehouse Connector updates the schema file for the stream. You
should reload the stream whenever you add a new custom meta to the Log Decoder or Decoder.

To reload the stream:

1. Goto ADMIN > Services.

& -

2. Inthe Services view, select the added Warehouse Connector service and select
Config.

> View >

The Services Config view of Warehouse Connector is displayed.
3. On the Streams tab, select the stream that you want to reload.

4. Click Reload.
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Specify Meta Filters for a Stream

You need to specify the filter for each stream in the export.session.meta.fields parameter in the
Explore view of the Warehouse Connector.

The following table lists the values that you can provide as a filter:

* All the collected metas are written to SAW.

* metal , meta2 All the metas except the defined metas are written to SAW.
For example,
Filter:*, ip.src

All the metas except ip.src is written to SAW.

metal, meta2, meta3 Only the defined metas are written to SAW.

Note: By default, the following metas are written to Warehouse even if you specify them in the filter:
- ng_source

- unique_id

- time

To specify meta filters for a Stream:

1. Goto ADMIN > Services.
.ﬁ. -

2. In the Services view, select a Warehouse Connector services and select > View > Explore.

The Explore view of the Warehouse Connector service is displayed.

RSA RESP INVESTIGATE MONITOR CONFIGURE ADMIN

% Change Service | Warehouse Connector | Explore

Warehouse Connector (Warehouse Connector)

= Warehouse Connect... <™

J2 = Warehouse Connector (WAREHOUSE C...

B[] connections
B logs
B rest

< >

3. In the options panel, select warehouseconnector > streams > <stream_name> > loader > config.
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In the export.session.meta.fields parameter, enter the filter.

RSA RESPOND

INVESTIGATE

MONITOR CONFIGURE

ADMIN

[©)

& Change Service | Warehouse Connector | Explore &
= /#warehouseconnector/streams/ loader/config Warehouse Connector (Warehouse Connector)
= Warehouse Connect...
150002 10231
2 & Warehouse Connector (WAREHOUSE _C.. ~
avro.load.interval 3
&[] connections bulcopy o
B010gs destination.online 1
B0 rest exportlog.enabled yes
B0 services exportrollup hour
80 storedproc export.session. enabled yes
B0sys export.session.meta.fislds *
BT users hold.count 100000
B [Jwarehouseconnector hold.interval 60
[ config 4 hold.size 512 MB
&[] destinarions Ioagar.stats.interval 1
[sources page.size 200000
Ostars permrejected.number [
B[ streams rejected.size [
[ Testing root festing
[cenfig thread.count 4
B[ loader thread.pool.count 3
Ceonfig use.compression deflate
stats wait.thread.pool 2
[schema &
< >

RS /\ NETWITNESS' PLATFORM

5. Restart the stream.
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Define Multi-valued Metas

You can also define an existing meta or a custom meta to be treated as multi-valued meta.

To define multi-valued metas:

Caution: Defining an existing meta to be treated as multi-valued may change the data type of the meta
and cause the associated reports to fail.

1. Create a new file with the filename multivalue-users.xml in the /etc/netwitness/ng directory.

2. Add the following entries:

<?xml version="1.0" encoding="utf-8"?>

<Netwitness>
<MultivalueMetas>

<Meta>NEWMETANAME</Meta>
</MultiValueMetas>

</Netwitness>

Where NEWMETANAME is the existing meta or a custom meta to be treated as multi-valued meta.

Caution: Make sure that you do not add metas that are by default treated as non multi-value.

3. Restart the stream.
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Manage a Lockbox

You can manage a lockbox using the following procedures:
o Change the Lockbox password

o Refresh the Lockbox

To change the Lockbox password:
1. Log on to NetWitness Platform.
2. Go to ADMIN > Services.

3. Inthe Services view, select the added Warehouse Connector service, and select - > View
> Config.

The Services Config view of Warehouse Connector is displayed.

RSA| RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

& Change Service | Warehouse Connector | Config &

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Source Configuration Destination Configuration

+ +

[ adaress pore O Name Type path

| 1031125245 56004 O nrFs nfs froot/test/kaushal
1 1031125248 56002 [ sFR sftp froot/test

R'S /\ NETWITNESS PLATFORM
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4. Click the Lockbox Settings tab.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

% Change Service | Warehouse Connector | Config

Sources and Destinations ~ Streams [EITUSSIAT General  Appliance Service Configuration

Create New Lockbox
et the lockbox password. The password should satisfy lockbox password strength.You will be required to enter this password to perform any lockbox management.
Lockbox Password FrEXEIEE

Confirm Lockbox Password FEERRE

Apply

Change Lockbox Password
Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password FREEAEAEE
[New Lockbox Password FkEREIEA

Confirm New Lockbox Password | **&*xxex

Apply

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password FHkRERE

Apply

5. Inthe Change Lockbox Password section, perform the following:
a. Inthe Current Lockbox Password ficld, enter the current lockbox password.

b. Inthe New Lockbox Password field, enter the new lockbox password.

Note: The lockbox password must be at least eight characters in length and it must contain at
least three of the following groups: one uppercase character [A-Z], one lowercase character
[a-z], one numeral [0-9], and one special character.

c. Inthe Confirm New Lockbox Password field, enter the new lockbox password to confirm.

d. Click Apply.
The Lockbox password is successfully changed.
To refresh the Lockbox:
1. Log on to NetWitness Platform.

2. Goto ADMIN > Services.
E o]

3. Inthe Services view, select the added Warehouse Connector service, and select > View

> Config.

45 Manage a Stream and Lockbox



Warehouse Connector Configuration Guide

The Services Config view of Warehouse Connector is displayed.

INVESTIGATE MONITOR CONFIGURE

& ChangeService | ‘Warehouse Connector | Config.

LIS ENRLEESIESSl  Streams  Lockbox Settings ~ General  Appliance Service Configuration

Source Configuration Destination Configuration

+ +

|| Address Port [0 Name Type Path

1 1031125245 56004 O NFs nfs /froot/test/kaushal
1 1031125248 56002 O sFe sftp froot/test

Click the Lockbox Settings tab.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN @ aamin

# Change Service | Warehouse Connector | Config

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Create New Lockbox
Set the lockbox password. The password should satisfy lockbox password strength You will be required to enter this password to perform any lockbox management.
Lockbox Password FEE

Confirm Lockbox Password

Apply

Change Lockbox Password
(Change the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.
Current Lockbox Password R
[New Lockbox Password R

Confirm New Lockbox Password | ***#*%%

Apply

Refresh Lockbox
Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password R

RS/ NETWITNI LATFORM

In the Refresh Lockbox section, enter the current lockbox password in the Lockbox Password
field.

Click Apply.

The Lockbox is reset.
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Warehouse Connector Configuration References

This section contains descriptions of the user interface as well as other reference information.
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General Tab Settings

The General tab displays the general configuration settings for Warehouse Connector service.

Workflow

You are here

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Analyze a Warehouse
Report

Configure the Data Source Configure a Stream
for Warehouse Connector

Monitor a Warehouse
Connector

Manage a Stream and
Lockbox

What do you want to do?

OO T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid
Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service
Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector
Administrator Configure the Destination using Configure the Destination Using NFS
NFS, SFTP, WebHDFS. Configure the Destination Using
SFTP
Configure the Destination Using
WebHDEFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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S T T

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox* Manage a Stream and Lockbox

*You can complete these tasks here.

Related topics

o Configure a Warehouse Connector Service

Quick Look

The following figure shows the General tab on the Warehouse Connector Services Config view.

The General tab displays the system configuration parameters for the Warehouse Connector service.

r | Config &

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

System Configuration

Name Config Value
Compression 0

Port 50020

SSL FIPS Mode [m)

SSL Port 56020

Stat Update Interval 1000
Threads 20

RS /\ NETWITNESS' PLATFORM

When you add a Warehouse Connector service, default values are in effect. RSA designed the default
values to accommodate most environments and recommends that you do not edit these values because it
may adversely affect performance.

The following table describes the System Configuration parameters:

m Config Value

Compression  Determines the minimum amount of bytes before a message is compressed. If set to
zero, messages are not compressed.
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m Config Value

Port Determines the port used by the service.

Note: If you change the port number, ensure that you restart the service.

SSL If enabled, all the data transferred in the network will be encrypted using SSL.

Stat Update Determines how often (in milliseconds) statistic nodes are updated in the system.
Interval

Threads Determines the number of threads in the thread pool to handle incoming requests.
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Appliance Service Configuration Tab Settings

The Appliance Service Configuration tab displays the appliance configuration settings for Warehouse
Connector service. For more information, see "Appliance Service Configuration" in the Hosts and
Services Getting Started Guide.

Workflow

You are here

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Configure a Stream Analyze a Warehouse

for Warehouse Connector Report

Monitor a Warehouse
Connector

Manage a Stream and
Lockbox

What do you want to do?

OO T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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S T T

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox* Manage a Stream and Lockbox

*You can complete these tasks here.

Related topics

o Configure a Warehouse Connector Service

Quick Look

The following figure shows the different settings on the Appliance Service Configuration tab.

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Name Config Value
Compression 0

Part 50006
S5LFIPS Mode: [}

SSLPort 56006

Stat Update Interval 1000

Threads 20

Apply

RS /\ NETWITNESS® PLATFORM

When you add a Warehouse Connector service, default values are in effect. RSA designed the default
values to accommodate most environments and recommends that you do not edit these values because it
may adversely affect performance.

The following table describes the Appliance Service Configuration parameters:

m Configuration Value

Compression  Determines the minimum amount of bytes before a message is compressed. If set to
zero, messages are not compressed.
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m Configuration Value

Port Determines the port used by the service.

Note: If you change the port number, ensure that you restart the service.

SSL FIPS If enabled, all the data transferred in the network will be encrypted using SSL FIPS.
Mode
SSL Port Determines the SSL port used by the service.

Stat Update Determines how often (in milliseconds) statistic nodes are updated in the system.
Interval

Threads Determines the number of threads in the thread pool to handle incoming requests.
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Sources and Destinations Configuration

The Sources and Destinations tab for a Warehouse Connector in the Services Config view provides a
way to manage basic service configuration and configure source and destination.

Workflow

Add Warehouse as a Data
Source to Reporting

Configure a Warehouse
Connector Service

Install Warehouse Connector
Service on a Log Decoder or
Decoder Engine

Analyze a Warehouse
Report

You are here

Configure a Stream

Configure the Data Source
for Warehouse Connector

Menitor a Warehouse
Connector

Manage a Stream and

Lockbox

What do you want to do?

OO T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid
Administrator Configure a Warehouse Connector  Configure a Warehouse Connector
Service Service
Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector™ Warehouse Connector
Administrator Configure the Destination using Configure the Destination Using NFS
k
INES;ISETIE, S ebHDES Configure the Destination Using
SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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S T T

Add Warehouse as Data Source to For more information, see "Add

Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator

For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Analyze a Warehouse Report

Administrator Manage a Stream and Lockbox Manage a Stream and Lockbox

*You can complete these tasks here.

Related topics

o Configure the Data Source for Warehouse Connector

« Configure the Destination

Quick Look

The following figure shows the Sources and Destinations tab on the Warehouse Connector Services
Config view.

£ ChangeService |  Warehouse Connector |  Config &

Sources and Destinations Streams 1 Lockbox Settings General Appliance Service Configuration

Source Configuration
+

] Adaress
[
[

port

56004
56002

Destination Configuration
+

O Name

[ nFs

0O srp

Type

stp

Path

Irootitestkaushal

Iroot/test

RS /\ NETWITNESS' PLATFORM

The Sources and Destinations tab includes the following two sections:

Source Configuration
Destination Configuration
Source Configuration

The Source Configuration section allows you to configure the data sources from which the Warehouse
Connector service needs to collect data.

The following is an example of the Source Configuration section.
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Source Configuration

+
O address Port
O 56004
Ol 56002

The Source Configuration section allows you to perform the following:

CEmEETN.

Add the data source.

- Delete the data source.

Destination Configuration
The Destination Configuration section allows you to configure the destination to which the Warehouse
Connector service needs to write the collected data.

Destination Configuration
=+
]| Mame Type Path
[ NFs nfs froot/test/
[ sFp sftp froot/test

The Destination Configuration section allows you to perform the following:

CCT N

Add the destination.

— Delete the destination.
] Edit the destination.
Note: You can only edit the SFTP destination
type.
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Add Stream Dialog

You can configure and add a stream to a Warehouse Connector in this dialog

Workflow

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Analyze a Warehouse
for Warehouse Connector Report

Menitor a Warehouse
Connector

Manage a Stream and

Lockbox

What do you want to do?

OO T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid

Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service Service

Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector

Administrator Configure the Destination using Configure the Destination Using NFS

NFS, SFTP, WebHDFS. Configure the Destination Using

SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream* Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.

Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox Manage a Stream and Lockbox

*You can complete these tasks here.

Related Topics

o Configure a Stream

Quick Look

The following figure is an example with the important features labeled.

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

Groups Services
+ s +o=-E| P @ | Fiter X
Name [} Name Licensed | Host Type Version Actions
Event Stream Analysis localhost.local ai 2 S Anal > )
S ol” t Stream Analyst ocalhost localdomain Jent Stream Analysis £ .
a Stream Analy localhest.localdomain Entity Behavior Analytics £ 28
a Inve: localhost.localdomain Investigate Server £ 28
a Log Collector localhost.localdomain Log Collector £ 28
a Log Collector localhost.localdomain Log Collector &
a Log Collector localhost.localdomain Log Collector &
[m] localhost.localdomain Log Decoder &
[m s localhost.localdomain Log Decoder &
[m] localhost localdomain Orchestration Server £o
[m] localhost.localdomain Reporting Engine Lo 2S
a localhost.localdomain Response Server TF o
a localhost.localdomain Security Server -
Werehouse Connector ocalhost localdomain arehouse Connector |
5 . . oo arhonee € System b oven ]
Delete
= Warehouse Connector localhost. i Connector  mTCmEEEE o v
e
| Page 1 of2 | }» DI C Eplrs o 25 0f 28

Logs Stop
RS /\ NETWITNESS PLATFORM Security Restart

RSA RESPOND INVESTIGATE MONITOR CONFIGURE ADMIN

# Change Service | Warehouse Connector | Config.

Lockbox Settings ‘General Appliance Service Configuration
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Add Stream

Stream Mame *

3 i * R N
Select Destination Choose Destination ... w

Select Source *

Ll Mame Address Port Session 1D
|:| 56004 Enter Session
|:| 56002 Enter Session

Cancel Save

Go to ADMIN > Services,
In the services view, select a Warehouse Connector service and select ¥ ~ >view>config

In the Streams tab, click + (0 view the add stream dialog.
The following table describes the fields in the Add Stream dialog:

Stream Type the name of the stream. The stream name may only contain alphanumeric
Name characters and underscores. It cannot exceed 20 characters in length.

Select Select a destination from the drop-down list.

Destination

Select Select a source from the grid at the bottom section of the dialog.

Source

Name The name of the source.

Address The address of the source.

Port The port of the source.

Session ID The session ID of the source.
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Streams Configuration

The Streams tab for a Warehouse Connector in the Services Config view provides a way to manage
stream configuration.

Workflow

Add Warehouse as a Data
Source to Reporting

Configure a Warehouse Configure a Destination

Connector Service

Install Warehouse Connector
Service on a Log Decoder or
Decoder Engine

Analyze a Warehouse
Report

Configure a Stream

Configure the Data Source
for Warehouse Connector

You are here

Menitor a Warehouse

| Connector

Manage a Stream and

Lockbox

What do you want to do?

OO T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid
Administrator Configure a Warehouse Connector Configure a Warehouse Connector
Service Service
Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector
Administrator Configure the Destination using Configure the Destination Using NFS
ESE BLE RS, Configure the Destination Using
SFTP
Configure the Destination Using
WebHDEFS
Administrator Configure a Stream™ Configure a Stream
Administrator Monitor a Warehouse Connector* Monitor a Warehouse Connector
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S T T

Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to
Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox Manage a Stream and Lockbox

*You can complete these tasks here.

Related topics
Configure a Stream

Quick Look

The following figure shows the Streams tab on the Warehouse Connector Services Config view.

r | Config ®

Lockbox Settings General Appliance Service Configuration

[To configure the alert m jisms related to the Warehouse Connector navigate here.

R'S/\ NETWITNESS' PLATFORM

The Streams tab allows you to perform the following:

e .

Add a stream.
- Delete a stream.
4 Edit the stream.
Start Start the stream.
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e reen

Stop Stop the stream.

Finalize  Finalize the stream.

reload Reload the stream.

If you have added a new meta or if a new meta is added as part of content update to any
of the sources, Log Decoder or Decoder, you need to reload the stream for the meta to be
visible in the schema for the Reporting Engine. Reloading a stream does not have any
impact on the data, but only the new meta list is fetched from the sources.

The following table describes the fields in the Streams tab:

Name Name of the stream.
Sources The sources associated with the stream.
Destination  The destinations associated with the stream.

Status Status of the stream.

Stream Statistics

You can view the statistics of a configured stream. Click the ® icon next to the name of the stream.

Destination Status

b 50002 a running

The following parameters are displayed in the Stream Statistics:

tn e o

Stream
Number of Determines the number of files in the permanent rejected folder
files in the (named, permfail) in the Warehouse Connector. The permanent
permanent rejected folder contains the files that Warehouse Connector failed to

rejected folder write to the destination.
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Rejected Determines the disk usage of the rejected folder.
folder usage
in percentage

Session Rate ~ Determines the rate at which the session is processed by the
Warehouse Connector for the source.

Destination
Status Indicates the status of the destination.
Source
Status Indicate the status of the source.
Sessions Determines that number of sessions that needs to be processed by the
Behind Warehouse Connector.

Last Session ~ Determines the last session id processed by the Warehouse Connector.
read

Change Stream Configuration

You can change configuration of a stream in runtime. In the Streams tab, click Change Configuration
to change the configuration of the selected stream.
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Change Configuration :

Stream Configuration

Name Config Value -
=l Aggregation Configuration

Ageregate max sessions 1000

Agegregation Interval 10

= Loader Settings

Compress files on disk. deflate
Export Rellup Interval hour
Maxirmum Message Hold Count 100000
Maximum Message Hold Interval (Seconds) o0
Maxirmum Message Hold Size 512 ME
Page Size 200000
Remote Export Path /
Session Meta Fields Exported *
Session Remote Export ™

=l Stream Settings

Auto Startup ]

You can change the following parameters of the Stream Configuration:

Note: If you change the value of any parameter in stream configuration, make sure that you restart the
stream.

After upgrading, if the values of Maximum Message Hold Count, Maximum Message Hold Interval and
Maximum Message Hold Size are 3000000, 60 and 128 respectively, ensure that you assign the following
values to the streams:

o Maximum Message Hold Count - 2400000
o Maximum Message Hold Interval - 600
o Maximum Message Hold Size - 512

You can assign these values by modifying the existing Stream configuration.
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Aggregation Configuration

Aggregate max Determines the maximum number of sessions in a response for an
sessions aggregation request from the Warehouse Connector to the source .

Aggregation Interval Determines the time between the responses from the source.
Loader Settings

Compress files on disk Enable to compress files on disk.
Supported values:
o Deflate - Provides smaller compressed files and good performance while
generating reports.

o Off
By default, the parameter is set to deflate,

Export Rollup Interval Determines the roll-up interval for export files and also the directory structure
the Warehouse Connector writes to the destination.
For example:
If the parameter is set to:

Value Directory Structure

hour  /rsasoc/v1/[logs | sessions]/data/{year}/
{month}/{day}/{hour}

minute /rsasoc/v1/[logs | sessions]/data/{year}/
{month}/{day}/{hour}/{minute }
day /rsasoc/v1/[logs | sessions]/data/{year}/
{month}/{day}
If you change the value of the parameter, ensure that you restart the stream.
Recommended value is hour,

Maximum Message Determines the maximum number of sessions to store in the memory before
Hold Count processing.

Note: If you have deployed a Warehouse Connector Virtual Appliance,
make sure that you change the default value of the parameter to 800000.

Maximum Message Determines the maximum time (in seconds) to hold the sessions in memory
Hold Interval before processing.

(Seconds)

Maximum Message Determines the maximum size for the sessions to store in the memory before
Hold Size processing.

Remote Export Path Determines the remote local mount point for HDFES (nfs://) and the location

to export the data.

Page Size Determines the maximum pages.
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Stream Settings

Auto Startup Enable to automatically start the stream whenever the Warehouse connector
process is restarted. By default, the parameter is set to off,
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Lockbox Settings

The Lockbox Settings tab for a Warehouse Connector in the Services Config view provide a way to
manage the lockbox settings.

Workflow

Install Warehouse Connector Configure a Warehouse Configure a Destination Add Warehouse as a Data
Service on a Log Decoder or Connector Service Source to Reporting
Decoder Engine

Configure the Data Source Configure a Stream Analyze a Warehouse
for Warehouse Connector Report

Meonitor a Warehouse

Connector

You are here

Manage a Stream and |

| Lockbox

What do you want to do?

S T T

Administrator Install Warehouse Connector Install Warehouse Connector Service
Service on a Log Decoder or on a Log Decoder or Decoder or
Decoder Hybrid
Administrator Configure a Warehouse Connector ~ Configure a Warehouse Connector
Service* Service
Administrator Configure the Data Source for Configure the Data Source for
Warehouse Connector Warehouse Connector
Administrator Configure the Destination using Configure the Destination Using NFS
WIS, BIFVIE, WElelHIbIRS. Configure the Destination Using
SFTP
Configure the Destination Using
WebHDFS
Administrator Configure a Stream Configure a Stream
Administrator Monitor a Warehouse Connector Monitor a Warehouse Connector
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Refer to...
Administrator Add Warehouse as Data Source to For more information, see "Add
Reporting Engine Warehouse as a Data Source to

Reporting Engine" in the Reporting
Engine Configuration Guide.

Administrator Analyze a Warehouse Report For more information, see "Step 4.
Analyze a Warehouse Report" in the
Warehouse Guide.

Administrator Manage a Stream and Lockbox* Manage a Stream and Lockbox

*You can complete these tasks here.

Related topics

o Configure a Warechouse Connector Service

o Manage a Stream and Lockbox

Quick Look

The following figure shows the Lockbox settings tab on the Warehouse Connector Services Config view.

-, Change Service Warehouse Connector |  Config ©

Sources and Destinations Streams Lockbox Settings General Appliance Service Configuration

Create New Lockbox

et the lockbox password, The password should satisfy lockbox password strength.You will be required to enter this passward to perform any lockbox management.

Lockbox Password kA
contirm Lockbox Password bk
Apply

Change Lockbox Password

fchange the lockbox password. You will be required to enter current password and new password.The password should satisfy lockbox password strength.

[Current Lockbox Password bkl

[New Lockbox Password faiaiatd

jConfirm New Lockbox Password | ks
Apply

Refresh Lockbox

[Reset the lockbox.You will be required to enter current lockbox password.

Lockbox Password FEEEEEE

T —

The Lockbox Settings tab allows you to set, change, or refresh the lockbox password of the Warehouse
Connector.
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